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Part 1

Starting with MacRuby

MacRuby is a combination of technologies that together create a power-
ful and very usable new technology. Part 1 of this book provides the basics
needed for new MacRuby users to understand the background and underlying
details of how MacRuby works so the development environment, language, and
platform make sense. With this grounding, you’ll be able to pick any sections in
the rest of the book and learn about the areas that are most interesting or rele-
vant to you.
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Introducing MacRuby

MacRuby gives you the ability to write full-fledged Mac applications while enjoying
the benefits of the Ruby language. You won’t take a deep dive into writing your first
releasable application worthy of the Mac App Store just yet—you’ll do that in chap-
ter 2. To write great MacRuby applications, you first need to become familiar with
its foundation. The MacRuby language is deeply rooted in the Ruby and Objective-
C languages so it’s important to have a good understanding of both of these to fully
leverage all that MacRuby offers.

 In this chapter, we’ll briefly cover the Cocoa framework, Ruby, and Objective-C.
After you have an understanding of these topics, we’ll dive into some real MacRuby
code. You’ll even get a chance to write a Hello World application; we’ll show you
two approaches to user interface development.

 To get started, let’s learn what MacRuby is all about and get it installed on your
system.

This chapter covers
■ Exploring and installing MacRuby
■ Important Cocoa concepts
■ Objective-C and Ruby fundamentals
■ MacRuby syntax and methods
■ Developing with the Xcode IDE
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1.1 Introducing MacRuby
MacRuby is an Apple-sponsored development project. Over the years, Apple has
shown support for Ruby as a language, and, since 2002, Apple has included Ruby as
part of the Mac OS X operating system. Apple bundled a Ruby Scripting Bridge imple-
mentation called RubyCocoa with Mac OS X Leopard. Prior to MacRuby, RubyCocoa
was the only way to work with Ruby and the Cocoa framework together.

 In this section, you’ll learn how MacRuby is different from past attempts at com-
bining Ruby and Objective-C and what makes it such a great language. We’ll also jump
right into getting MacRuby installed onto your system and introduce you to Mac-
Ruby’s class structure.

 Let’s set the stage for MacRuby.

1.1.1 The MacRuby difference

The goal of MacRuby is to provide an implementation of the Ruby language on top of
core Mac OS X technologies, such as the Objective-C runtime, garbage collection, and
Core Foundation. In MacRuby, all classes are Objective-C classes, all methods are
Objective-C methods, and all objects are Objective-C objects. Unlike RubyCocoa, you
don’t need a bridge between Ruby, Objective-C, and the Cocoa framework. MacRuby
is implemented on top of the Objective-C runtime as shown in figure 1.1.

 MacRuby gives you the ability to do almost any-
thing you want with the Mac platform—all while giv-
ing you the clean, concise syntax of the Ruby
language. Another thing that sets it apart from
RubyCocoa is that you get this functionality without
making performance sacrifices because MacRuby
doesn’t rely on a bridge implementation.

 MacRuby is similar in concept to the IronRuby
and JRuby projects in that it’s an implementation of
Ruby on top of another runtime. IronRuby runs on the .NET runtime for Windows,
and JRuby runs on the Java Virtual Machine (JVM) runtime. MacRuby is currently
under active development by Apple, which gives the language a great deal of support
and momentum.

 Think of MacRuby as the child of two languages: Objective-C and Ruby. MacRuby is
rooted in the Objective-C object hierarchy, but it also has the Ruby 1.9 core function-
ality layered on top. Syntax-wise, MacRuby resembles Ruby more than Objective-C.
Theoretically, you could write a Ruby 1.9 script and run it under MacRuby. The key dif-
ference in MacRuby is that you can directly access Objective-C frameworks, classes,
objects, and methods.

 Before you write any code, you’ll want to install MacRuby and Xcode on your sys-
tem. Xcode is Apple’s suite of developer tools needed to create Mac OS X applications.
After all, what good are code examples if you can’t follow along?

Objective-C

Objective-C runtime

MacRuby

Cocoa libraries Ruby libraries

Figure 1.1 MacRuby is built on top 
of the Objective-C runtime.
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1.1.2 Setting up your environment

Install the Xcode development environment first. It’s best to install MacRuby after you
have Xcode set up on your machine. If you don’t install in this order, tools such as
Interface Builder (which is now built into Xcode 4) won’t be able to recognize your
MacRuby code.

INSTALLING XCODE

Registered Apple Developers can download the latest version of Xcode for free at
https://developer.apple.com/xcode/. If you don’t have an Apple Developer Account,
you can purchase Xcode for $4.99 from the Mac App Store.

TIP Xcode is a big file; take a break while you wait for it to download.

After the download is complete, run the installer to set up Xcode on your system.
Xcode will be available from your /Developer/Applications folder.

INSTALLING MACRUBY

Installing MacRuby is a simple two-step process:

NOTE Make sure that you’re running an Intel-based system with Mac OS X
10.6 or higher, which is the minimum requirement for MacRuby.

1 Download the latest stable release. From http://macruby.org, proceed to the
download section. A self-installable binary should be available for you to save
and run, which should install the latest version of MacRuby on your system.

2 Test the MacRuby installation. Open the Terminal application, type macirb,
and then press Enter. You should see something similar to the following code:

$ macirb
irb(main):001:0>

This puts you directly into Macirb, the MacRuby console, which is a great tool
for experimenting with MacRuby. You’ll learn about Macirb in more detail in
chapter 2.

Next, type this command:

p "Hello World!"

If your installation was successful, you’ll see the words Hello World! printed out
without any errors. If you see errors, try installing again.

NOTE If Xcode doesn’t recognize MacRuby files, return to this page and re-
install MacRuby.

If everything went as planned, congratulations! You’ve written your first line of Mac-
Ruby! You can now follow along throughout the book. Let’s start with a MacRuby
script. 
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1.1.3 Hello World, part 1

The MacRuby scripting runtime provides a way to
execute MacRuby scripts as Cocoa applications,
without the need for any other tools. To get a taste
of MacRuby, you’re going to write a script that,
when run, looks like figure 1.2.

 Open your favorite text editor, and create a file
and save it with the name hello.rb. The .rb indicates
that it’s a Ruby source file. MacRuby uses the same file extension as standard Ruby,
but it uses its own command to run scripts, as you’ll soon see.

 The Hello World application shown in listing 1.1 is 25 lines long because you’re
creating it programmatically rather than using the interface development tools built
into Xcode. Most of the code is for the user interface, which is why most people
choose to use HotCocoa or Xcode.

 Let’s start by looking at the code in the script, and then we’ll break it down into
digestible bits.

framework 'cocoa'

app = NSApplication.sharedApplication   

win = NSWindow.alloc.initWithContentRect

➥ ([300,500,400,200],  
➥ styleMask:NSTitledWindowMask | NSClosableWindowMask     
➥ | NSMiniaturizableWindowMask | NSResizableWindowMask,   
➥ backing: NSBackingStoreBuffered, defer:false)      

label = NSTextField.alloc.initWithFrame

➥ CGRectMake(0,0,250, 45))  
label.setStringValue "Hello World!"                            
label.drawsBackground = false                                 
label.bezeled = false                                      
label.font = NSFont.fontWithName("Arial", size:45.0)          
label.editable = false                                  

label.frameOrigin = NSMakePoint

➥ ((win.contentView.frameSize.width/2.0)
➥ -(label.frameSize.width/2.0),                                  
➥ (win.contentView.frameSize.height/2.0)                      
➥ -(label.frameSize.height/2.0) )                  

win.contentView.addSubview(label)  

win.title = "Hello World"                        
win.display                                      
win.orderFrontRegardless                  
win.makeKeyWindow           

app.run

Listing 1.1 MacRuby Hello World script

Figure 1.2 The MacRuby script in 
action
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The first line uses the framework method to load the Cocoa base framework for Mac-
Ruby. This method loads both the Foundation and AppKit frameworks into your envi-
ronment so that your application has access to the core Cocoa classes.

 You start by initializing the NSApplication singleton B for the app. Every Cocoa
program has a singleton instance of NSApplication responsible for managing the
application’s run loop. You create a variable, app, and assign it a reference to the
NSApplication singleton.

 Next, you set up the application window. At c, you create an instance of NSWindow
with parameters and assign it to the win variable for reference. To add subviews to the
application, you reference the main window (win). You also specify the size of the win-
dow as the first parameter of the NSWindow instance.

 To display the Hello World! message, you need an element to display the text. You
create an instance of NSTextField d and then set the text for it to Hello World! You
also set its bounds so that it displays centered in the window e. The frame origin of the
text field is set to roughly the center of the window based on the window’s dimensions.

 Next, you add the text field as a subview of the application window’s content view f.
The view hierarchy in Cocoa lets you easily add views on top of existing views.

 You finish by setting the application window title, and telling the window to display
and then become the front key window g. Finally, you tell the NSApplication
instance to run the application.

 That may have felt heavy for a Hello World, but that’s because there was a good
amount of setup for the interface elements. To run the script, type the following in
the terminal (assuming you’ve named your script hello.rb):
macruby hello.rb

 When the application runs, you’ll see the application window appear (see figure
1.2). You created a simple Hello World application using a single MacRuby script. In
reality, you aren’t likely to write too many apps like this. But this is a great way to ini-
tially dip your toes into Cocoa and MacRuby. This script uses a few of the core classes
from the Cocoa frameworks—the most important of these are NSApplication and
NSWindow. Every Cocoa application works with NSApplication. It’s also likely that
you’ll be dealing with NSWindow in your applications. To get a feel for the common
operations and functions available to these two classes, we recommend that you read
the Cocoa API documentation for both of them. You’ll build several applications
throughout this book that use these classes.

 Before we look any further at MacRuby, it’s important that you learn (or, in some
cases, review) a few concepts about Cocoa, Objective-C, and Ruby. 

1.2 Cocoa: What you need to know
To fully understand and appreciate MacRuby, you’ll need to learn a little about Cocoa
development. If you’re already familiar with Cocoa, feel free to skip this section.
Cocoa is the high-level programming API for Mac OS X and is widely considered the
best programming environment for writing native Mac applications. As an API, Cocoa
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provides an elegant way to interact with the operating system and the window man-
ager. Cocoa consists of a powerful set of libraries. Known as frameworks, they cover vir-
tually every task imaginable to work with the operating system, and they provide a
great set of tools for writing desktop applications.

 In this section, we’ll first discuss Cocoa’s important classes and concepts, and then
give you a brief overview of frequently used design patterns.

1.2.1 Important classes and concepts

What makes an application a Cocoa program? Is it the language? The tools you use?
The platform it’s running on? The answer to all these questions is no. What makes a
program a Cocoa program is that all the objects inherit from the root class NSObject
and can run on the Objective-C runtime.

 The NSObject class is defined in the Foundation framework. In Cocoa program-
ming, the two core frameworks are Foundation and Application Kit (AppKit for
short), which provide the core set of libraries that you need to write a Mac applica-
tion. When you wrote your Hello World script, you may have noticed that both frame-
works are required for Mac application development. All other frameworks that you
may include in your project can be viewed as optional.

Let’s take a closer look at the Foundation framework.

FOUNDATION FRAMEWORK

The Foundation framework provides a set of classes that act as the support layer for
your Cocoa applications. Whether a class is in Foundation or in AppKit is determined
by one factor: its role in the user interface. If a class doesn’t exclusively interact with
the user interface then it’s part of Foundation; if it does, it’s part of AppKit.

 Foundation supports several paradigms that include the following:

■ Object retention and disposal—Foundation and the runtime provide two ways for
Cocoa applications to manage objects: the older style of manual management
using retain/release memory references and the newer garbage collection tech-
nology. For our purposes, all you need to know is that garbage collection is
available in Objective-C 2.0, because MacRuby, at least for now, relies on it to
manage memory under the hood.

■ Mutable class variants—Many of the data-handling classes in Foundation have
both an immutable base class and mutable subclasses—these include NSArray,

About the NS name prefix

The classes, data types, constants and functions defined in Foundation and AppKit
have a name prefix of NS. The NS is a holdover from Steve Jobs’ old company,
NeXTSTEP, and—you guessed it—it stands for NeXTSTEP. You’ll see more of the NS
name prefix as you develop in Cocoa and MacRuby.



9Cocoa: What you need to know

NSDictionary, NSString, and many more classes. To modify the data after ini-
tialization, you need to use a mutable variant. You’ll find that MacRuby does
this for the classes that underlie its array, hash and string classes.

■ Notifications—Notifications are used heavily in Cocoa, and we’ll discuss the
Cocoa view of the design pattern in the next section. In general, notifications
provide a broadcast mechanism for inter-object communication in synchro-
nous, asynchronous, and distributed modes.

Foundation is the framework responsible for handling the base value objects in your
Cocoa application. These include primitive types, structures, and pointers. Founda-
tion is responsible for collection objects such as arrays and hashes (NSArray,
NSDictionary). The framework provides enumerators and, as already mentioned,
both mutable and immutable variants.

 As a quick overview, Foundation framework also supports these functional areas:

■ Operating system services—File system, threading, networking
■ Archiving and serialization
■ XML processing
■ Scripting
■ Expressions
■ Many more

The other important framework we mentioned was the AppKit framework, which is
short for Application Kit. Let’s see how this framework can help you with your
UI-based Mac applications. 

APPLICATION KIT FRAMEWORK

The Mac OS X user interface is an event-driven system, and AppKit provides the classes
you need to interact with this event-driven GUI. AppKit provides a large number of UI
components; its classes indirectly support the UI components.

 AppKit provides the Application object that each Cocoa app will have as a single-
ton instance for running in the main event loop. AppKit also gives you access to UI
objects such as windows, views, menus, cursors, table views, and most anything needed
to create a robust user interface.

 You’re interacting with AppKit when you use MacRuby code to manipulate the UI.
You can also interact with AppKit with different tools, such as Xcode and HotCocoa. If
you’re not familiar with HotCocoa, it’s a layer of Ruby mappings on top of Cocoa that
allow you to quickly construct interfaces programmatically. We’ll introduce HotCocoa
in more detail in chapter 9. Some of the other functions that AppKit provides are
graphics and color, internationalization, printing, and faxing.

NOTE For a full description of the capabilities of Foundation and AppKit, see
Apple’s Cocoa Fundamentals Guide (http://mng.bz/HT7j). 
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1.2.2 How Cocoa implements common design patterns

Cocoa often applies a design pattern to make use of the language and runtime capa-
bilities that Objective-C provides. According to Apple, Cocoa puts its own distinctive
spin on a pattern because its designs are influenced by factors such as language capa-
bilities or existing architectures. Some of Cocoa’s variations on common design pat-
terns may differ from their canonical usage or how you’re used to seeing them
applied. Cocoa relies on three common patterns.

DELEGATION

Delegation is a huge part of Cocoa. In the time that I’ve (Brendan) been program-
ming with Cocoa, I’ve used delegation more than I think I ever have in my life. Dele-
gation is a mechanism that’s leveraged throughout the API’s; if you understand and
make use of delegation, it can be a great tool in writing Cocoa applications.

 The delegation mechanism relies on two objects, a host and a delegate. The host
object delegates a task to the delegate object.

 To delegate certain actions/methods, the host object passes the messages it
receives to the delegate object. Delegate methods are defined in classes that serve as
protocols, which are declared methods that can be implemented by any class.

 In Cocoa, you can define a protocol as either formal or informal when you’re defin-
ing the interface that an object can delegate to another. A formal protocol requires
you to implement the protocol in the delegate. Informal protocols, however, allow you
to implement only the methods you want to respond to.

 When the host receives a delegate message, it first sends the respondsToSelector:
message to check with its delegate whether the method has been implemented. If so,
the host invokes that method. This check allows the host to avoid exceptions when
passing along the message.

NOTIFICATIONS

Notifications in Cocoa are a variation on the Observer pattern. Notifications are a
one-to-many broadcast mechanism in which objects can add themselves or other
objects to a list of observers of notifications. An object can observe many notifications,
where each notification is identified using a global string identifier.

 To post a notification, an object creates a notification object and sends it to a noti-
fication center to be broadcast. To observe a notification, you give the notification

Warning: delegate method signatures

When you work with delegates you have to be extremely careful that you’re defining
the delegate method signatures correctly in your delegate objects. The host won’t pass
on the message to the delegate if the delegate has a typo or the wrong method name
because it will fail the respondsToSelector: check. You won’t see any errors if this
happens, but you should notice that your delegate method is never getting called. If
you have trouble with delegates, remember to double-check the method signature!
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center a selector (reference to a specific method) on the object that it’s going to be
observing. When the notification is received, this selector is then called on the object
that is performing the observations. An observer’s selector should conform to the
notification method signature, which takes one parameter, the NSNotification
object itself:

- (void) somethingHappened:(NSNotification*):notification {...}

It’s standard practice for all methods that are given as receivers of notifications to use
this parameter. 

MODEL-VIEW-CONTROLLER

The world of web development has brought the model-view-controller (MVC) design
pattern to the forefront in recent years. If you’re a Rubyist (or an aspiring Rubyist),
you’ve likely had some exposure to this pattern via the Ruby on Rails web framework,
which makes heavy use of this pattern. Ruby on Rails provides a full MVC architecture
right out the box every time you start a new project. The MVC pattern is well defined
and easy to recognize in a Rails application—right down to the folder structure, which
has separation for models, views, and controllers. In Cocoa applications, the separa-
tion between roles and the function of each isn’t always as clear-cut.

 Ideally, models are responsible for encapsulating data and handling the business
logic related to that data. Views are responsible for presenting information to the user
and, often, for formatting and styling that presentation. Controllers act as the inter-
mediary between the models and the views, often controlling access and telling views
when data in a model changes.

 In general, when applying MVC, you should have objects that play each of the three
roles distinctly. Cocoa is much more apt than Rails to have objects play dual roles,
often either as controller-views or controller-models. Cocoa’s tendency to enforce less
strict separation in the application and folder structure itself plays a big part in why it
tends toward dual roles.

 Cocoa makes use of many other design patterns, although the three described
here are probably the most common in day-to-day Cocoa programming. You can dig
into more information on Cocoa and its design pattern usage in the Cocoa Fundamen-
tals Guide. 

COCOA WRAP-UP

We touched on enough parts of the Cocoa development framework for you to be
familiar with the framework. Both the Apple developer sites and the API documenta-
tion provide ample information about Cocoa. To learn more about the framework, we
recommend looking there first.

 Now that you’ve been introduced to Cocoa, we’ll turn our attention to the two lan-
guages MacRuby development depends on—Objective-C and Ruby. 

1.3 Objective-C and Ruby: what you need to know
MacRuby is interesting in that it’s literally a combination of Objective-C and Ruby.
The goal of this section is to introduce you to both Ruby and Objective-C. We’ll survey
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each language and show you its syntax. We’ll also cover the key parts of each language
that you should be aware of when working with MacRuby. Because MacRuby is written
in and sits on top of Objective-C, the more you understand Objective-C and how it
works the better off you’ll be. Likewise, the more you know about standard Ruby, the
quicker you’ll pick up MacRuby. As you’ll soon see, it pays to know a bit about both of
these great languages.

1.3.1 A shared heritage

Smalltalk is an object-oriented language that pre-dates Ruby and Objective-C. A
dynamically typed, reflective programming language, Smalltalk is historically significant
because of its influence on languages, such as Objective-C and Ruby. A language is
said to be dynamically typed when it does most of its type-checking at runtime rather
than during compilation. For instance, in Ruby, you don’t need to explicitly specify
whether something is an integer or a string. A reflective language allows you to write
code that can effectively observe and modify its own behavior.

 At a high level, Objective-C and Ruby share a surprising number of features also
found in Smalltalk. Both languages provide a dynamic runtime, use message passing,
allow runtime access to class and object information, and support metaclasses, to
name a few.

If you’re familiar with one language and not the other, you’ll find that, at a conceptual
level, you can solve problems similarly in either Objective-C or Ruby.

 One of the most significant similarities between Ruby and Objective-C is the
dynamic runtime, which makes it much easier to model Ruby in Objective-C. Shar-
ing a dynamic runtime allows MacRuby to fully support both standard Ruby and
Objective-C functionality. You get two for the price of one. Also, the dynamic nature
that makes Ruby so flexible is available in MacRuby.

 One of the standout features of Objective-C is its dynamic runtime, which still pro-
vides the speed advantages of a native compiled language and has access to both C
and C++ as needed. The ability to make runtime class modifications and handle mes-
sage redirection (both of which could be considered advanced programming topics)
are also key features of the Ruby language.

 If this is new to you, don’t worry. As we revisit these concepts throughout the book,
you’ll understand why and where the dynamic runtime comes into play. 

Message passing

Message passing is similar to method calling. The main difference is that message
passing requires a lookup to make sure the method exists before jumping to it during
runtime, whereas message calling calls the method directly without doing a check.
Message-passing support is one of the reasons that languages such as Smalltalk,
Objective-C, and Ruby are considered dynamic.
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1.3.2 Objective-C 101

Objective-C was developed as an extension to the C language. It’s object-oriented and
is the primary language of Apple’s Cocoa API. We’ll go over the basics of the language:
its syntax, class structure, methods, frameworks, and how to use the documentation. If
you’re already familiar with Objective-C, feel free to jump to the next section.

BASICS

Unlike Ruby, Objective-C is a compiled language. The IDE of choice is Apple’s Xcode,
which allows you to create, compile, debug, and package your applications. Xcode 4
comes with Interface Builder built in, which allows you to create user interfaces for
your Cocoa applications.

 Although it’s best to stick with the Xcode development environment, you have
other choices. If you’re a TextMate fan, you can use a bundle to write Objective-C, but
the bundle still needs to utilize Xcode for compilation and packaging. The KDevelop
IDE is also an option, but it’s not widely adopted.

SYNTAX

The message-passing syntax is the most important Objective-C concept you need to
know. Because MacRuby can call all the Objective-C API functions, it’s beneficial to
know how to call those functions and what the method signatures look like. You’ll
often have to translate an Objective-C method signature into the appropriate MacRuby
equivalent to call the API function you want to use. Let’s go over a few operations using
Objective-C to get familiar with its syntax. First, create an instance of an array:

NSArray *myArray = [NSArray alloc];
[myArray init];

What’s this code doing? You call a class method, alloc, on the NSArray class and then
assign the result to a pointer of type NSArray. In the next line, you call the instance
method, init, on the resulting NSArray object.

 The following code shows the same example, but this time, you’re using message
passing, and you need only one line of code:

NSArray *myArray = [[NSArray alloc] init];

The important thing to take away from this example is the message-passing syntax. In
Objective-C, you can invoke a method on an object using the bracket syntax you just
used. To illustrate how the syntax works, consider the following code:

[[someObject someMethod] anotherMethod];

In this example, someObject is the receiver of the message, someMethod. The result of
this message then becomes the receiver of the message, anotherMethod.

 You can also pass parameters with a message. 

CALLING METHODS

Objective-C uses a named-parameter approach, which might seem strange at first if
you’re not familiar with it. After you get used to it, though, you’ll find reading the
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Apple developer documentation simple. In Objective-C, the parameters are part of
the method name; you don’t need to pass in a separate parameter list as you do in
many other languages. A parameter is denoted by a colon at the end of its name.

 Let’s take a typical example of instantiating an NSTimer that fires once after a
40-millisecond delay. The following method has five parameters:

scheduledTimerWithTimeInterval:target:selector:userInfo:repeats:

Yes, that whole line is the name of one single method. The parameters and colons
make up the name of the function. It might take a little getting used to, but if you take
the time to understand the syntax, you’ll quickly amass the Cocoa API documentation,
which is a necessary resource for Mac development.

 To use the method in an application, it looks like this:

[NSTimer scheduledTimerWithTimeInterval:0.40f target:self

➥ selector:@selector(doSomethingOnTimer) userInfo:nil repeats:NO];

You first call a class method on the NSTimer class. As you can see, NSTimer is the
receiver of the method call. You then call the method that we just described, but this
time using real parameters:

■ scheduledTimerWithTimeInterval:0.40f is passed a float value of 0.40.
■ target:self is passed the value self, which lets the method know that the class

that’s making this method call is the target for the following selector parameter.
■ selector:@selector(doSomethingOnTimer specifies a selector (we’ll be going

over this in detail next).
■ userInfo:nil is passed a value of nil, which is a null value.
■ repeats:NO is passed a BOOL (Boolean) value, NO.

Let’s discuss selectors so that we can further explain that selector parameter. 

METHOD SELECTORS

Objective-C supports dynamic message-passing using something called a method selec-
tor. In strict terms, a method selector can be thought of in two ways. First, it’s the name
of the method as referred to in source code. Second, the method selector is the
unique identifier that replaces the method name when you reference the method.
Simply put, selectors allow you to dynamically denote method names and identifiers.
Objective-C uses a specific data type, SEL, to represent the unique selector ID. You can
use a selector to invoke an SEL method on an object. This technique supports the tar-
get-action design pattern used heavily in Cocoa development. You’ll learn more about
target-action in chapter 2.

 In code, you can refer to a compiled selector using the @selector() directive. The
most common use for this is when you invoke a method that expects a callback
method as a parameter. To specify which method should be invoked, you use the
@selector reference.

 Look again at the method signature for the NSTimer example, and examine the
selector parameter:
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[NSTimer scheduledTimerWithTimeInterval:0.40f target:self 

➥ selector:@selector(doSomethingOnTimer) userInfo:nil repeats:NO];

You pass the @selector directive a method name; in this case, it’s doSomethingOn-
Timer. When the timer hits its time threshold, it’s going to call that method.

 Remember the second parameter, target? You pass in self, which means that the
object from which you call this function is the target for the doSomethingOnTimer
selector. You define the doSomethingOnTimer method in the same class from which
you call the NSTimer method because you’re passing the class as the target for the
selector. The combination of the target: and selector: parameters is the equivalent
of having the timer run this line of code:

[self doSomethingOnTimer];

Selectors are a powerful feature when implementing dynamic functionality in your
applications. They also map well to the Ruby dynamic evaluation techniques, such as
send(), eval(), class_eval(), instance_eval(), and so on.

CLASSES

Creating classes in Objective-C requires two files. One file acts as the interface and the
other acts as the implementation. The interface file, typically saved with a .h exten-
sion, is where you define your instance variables and your public methods. The imple-
mentation file, saved with a .m extension, is where you implement the code for
methods defined in the interface as well as any private methods you want to include.

 Let’s create interface and implementation files for a class called Book. First, let’s
examine the interface file, Cocoa.h:

#import <Cocoa/Cocoa.h>

@interface Book : NSObject {
  NSString *title;
  NSString *authors;
}

The importance of colon placement

When working with selectors, be aware of a common error. Consider the following two
@selector directives:

@selector(someMethod)
@selector(someMethod:)

Notice the difference? The second has a trailing colon, which is a critical distinction.
A selector with no trailing colon indicates a method with no parameters, whereas a
selector with a trailing colon indicates a method with one parameter. 

Be aware of this difference because it’s all too easy to forget or to mistakenly add
an extra colon to your selector, which causes errors and potential bugs. 
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- (NSString *) title;
- (NSString *) authors;

@end

You first import the Cocoa framework to pull in the resources you need for a Cocoa
application. On the next line, you can see that you call this class Book and that it’s a
subclass of the NSObject class. Inside the curly braces, you define two instance vari-
ables, which are of class NSString. The next two lines outside the curly braces are get-
ter methods for the instance variables, title, and authors. Notice how NSString is
inside parentheses on these two lines? That’s the return type for that specific method.
Also, in Objective-C, it’s conventional to leave out the get prefix for getter methods.

 The following code is the implementation file, Book.m:

#import "Book.h"

@implementation Book

- (NSString *) title {
  return [NSString stringWithString:@"MacRuby in Action"];
}

- (NSString *) authors {
  return [NSString stringWithString:@"Brendan G. Lim & Paul Crawford"];
}

@end

In the implementation of the Book class, you first import the interface file you cre-
ated. You then declare the implementation and specify the class name, Book. The next
lines are custom getters for the instance variables, implemented in a simple fashion.
You return a new NSString for each method.

Let’s move on to frameworks, which play a large part in Objective-C development. 

FRAMEWORKS

Frameworks are collections of classes that provide a set of functionality. Frameworks is
the term Cocoa uses for libraries. Apple provides many different frameworks, and you

Dealing with garbage collection and memory management

If you’ve developed iOS or Cocoa applications before, you’ve probably had to worry
about releasing memory that was allocated for certain objects in your application. Man-
ual memory management can certainly be a big barrier to entry for those who are new
to iOS development. Not many people like having to make sure they’re properly freeing
up memory; they expect this to be automated for them. Luckily for us, MacRuby uses
the Objective-C garbage collection engine, which has been available since Objective-
C 2.0. With garbage collection, you don’t need to worry about manually releasing ob-
jects created throughout your application.
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can make use of Objective-C frameworks directly in MacRuby using the framework
directive, which we’ll explain in chapter 2. Frameworks provide an efficient code-
organization mechanism for separation of disparate functionality. Some of the most
common frameworks include Foundation, AppKit, and CoreGraphics. As you make
use of different OS X capabilities in your applications, the variety of frameworks that
Apple provides will come in handy.

APPLE DEVELOPER DOCUMENTATION

The Apple developer documentation is a great tool for learning about the methods
available on any of the Cocoa classes. Figure 1.3 shows the documentation for the
method you used on the NSTimer class in the previous examples.

 In figure 1.3, the documentation lists the five parameters for this method, and
indicates their data types in the description. To access other API documentation, start
up Xcode and choose Help > Documentation. Use the search bar to search for com-
mon classes. We recommend looking at something like NSString or NSArray to see
how Objective-C defines common-operation functions for strings and arrays.

OBJECTIVE-C WRAP-UP

We’ve only scratched the surface of Objective-C development, but you’ve learned
enough to understand the Objective-C code examples throughout the book. Because
MacRuby’s usefulness is heavily reliant on the Cocoa API, it’s important to be able to
read Objective-C code, especially when diving through the developer documentation.
Now, let’s turn to the Ruby language. 

1.3.3 Ruby 101

Because MacRuby’s syntax is much like Ruby, it’s important that you spend a little
time understanding it. More than likely, you’re already experienced with the Ruby

Figure 1.3 Documentation for the NSTimer class
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language and can feel free to skip this section. If you’re not, it’s important to continue
learning about Ruby because you’ll be using it to write MacRuby. Ruby is a concise
and simple language. Let’s take a look at a few operations in code so you can see what
we mean.

BASICS

Ruby classes are defined in a single class file ending with a .rb extension; in fact all Ruby
source files end in a .rb extension. Typically, to run a Ruby script, you use the Ruby exe-
cutable (ruby) to run the script. Ruby, like many programming languages, doesn’t
require much in terms of tools. You can use any text editor to write and edit Ruby source
files. At the least, we recommend using a text editor that supports syntax highlighting
for Ruby (which will work for most MacRuby syntax as well). When you’re working with
MacRuby, you always have the option of using Xcode.

OBJECTS

Ruby is all about objects. Everything in Ruby is an object, and we mean everything!
Other languages use simple data types that aren’t first-class objects. For example, a
number literal might be a data type of integer, but it isn’t, in fact, an object of class
Integer.

 In Ruby, when you type 1, you have an object of class Fixnum, and you can call
methods directly on what looks like a literal. Let’s try this out in Irb.

 Open Irb (or if you prefer, use Macirb, which we’ll explore in chapter 2), and type
the code as shown in the following listing.

>> 1.class
=> Fixnum
>> 1.methods
=> ["%", "odd?", "inspect", "prec_i", "to_yaml",
"taguri", "<<", "tap", "div", "", "po", "clone", ">>",
"public_methods", "object_id", "__send__", "taguri=",
"denominator", "instance_variable_defined?", "equal?"...

To get a feel for Ruby, try out a few more things in Irb right now. Use the method,
methods, to see what methods are available on an object; use the method, class, to
see what the class of an object is. Explore a little, and call some methods on the string
"Ruby" to see what you get. 

CALLING METHODS

Ruby is a flexible language. So what, right? Many programming languages are flexible.
What makes Ruby stand out is that the language provides more than one way to do
something, even important things like calling methods. When you’re reading someone
else’s Ruby code, it’s helpful to know that Ruby provides various ways to accomplish
common tasks. Consider the most common operation you can do in Ruby: calling
methods. There are a few ways you can do this.

Listing 1.2 Inspecting Ruby classes and methods
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 Suppose you have a string, and you want to reverse the characters in it. You can use
the String#reverse method to accomplish this. In message-passing terms, the string
racecar is the receiver and the method reverse is the message. All three of these state-
ments are equivalent:

"racecar".reverse()
"racecar".reverse
"racecar".send(:reverse)

The second option is the most typically used way to call methods. In Ruby, parenthe-
ses are optional on method calls, and, often, you need to use them only to help with
readability when you make nested method calls. The third option uses one of Ruby’s
metaprogramming features, the send method, which allows you to specify a string or
symbol that will be treated as a method name.

 Ruby uses a dot notation for method calls that looks like this: receiver.message.
If you don’t use the dot notation, then it’s implied by Ruby that the receiver for that
message will be self, the current object.

 Determining what self is in any given context can be confusing, although the
most common cases are either the class or instance context for a given object. If
you’re working in a class definition, you’ll likely be dealing with self either when
self is the class or when self is an instance of the class. This example calls the kernel
method puts to output a string to stdout:

puts "Hello World!"

You can call many kernel methods without an explicit receiver. They’re made available
to every Ruby object. The most common kernel methods are used for raising excep-
tions, requiring other Ruby source files, and accessing metaprogramming functional-
ity, such as creating anonymous functions. See the Ruby documentation for kernel to
get an idea of what’s available. 

CLASSES

Ruby classes are simple to define. They don’t require a lot of boilerplate code, and
with shortcut methods, it’s easy to create getter and setter methods for attributes. A
class is defined by the kernel method class, which behaves like a keyword in other
languages and takes a Ruby block that defines the class functionality (we’ll discuss
blocks shortly).

 Let’s create a Ruby class file that creates the class Book and gives it some attributes
and methods:

class Book
  attr_accessor :title, :price
  
  def initialize(title, price)
    @title = title
    @price = price
  end
  
  def increase_price(amount)
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    @price += amount
  end
end

After you define the class Book, you call the method attr_accessor, which sets up the
instance variables title and price. The result is that you have getter and setter behav-
ior on Book instances for those two attributes and a local variable for each in the Book
class. You can take an instance of Book and call book.title or book.title = "foo"
without having to define the getter and setter methods yourself.

 In Ruby, the new method is used to create a new instance of an object, and it’s the
standard constructor for Ruby objects. When you define a Ruby class, you don’t
implement a new method; instead, you implement the initialize method. This is
the method used to initialize the instance of the object. Here you implement an
initialize method that sets the title and price of the Book variables to the values
that are passed in.

 Methods are defined using def, which is given the method name, a parameter list,
and a block that defines the functionality of the method. In this case, you define the
method increase_price with the parameter amount. This is an instance method avail-
able to instances of the Book class.

 Let’s see what you can do with this Book class. If you instantiate a new Book without
passing any parameters to new, you get the following error:

>> book = Book.new
ArgumentError: wrong number of arguments (0 for 2)
from (irb):15:in 'initialize'
from (irb):15:in 'new'
from (irb):15

When you initialize a new Book, you need to pass in the title and price parameters:

>> book = Book.new("MacRuby in Action", 10.00)
=> #<Book:0x1077514 @price=10.0, @title="MacRuby in Action">

You now have an instance of Book, let's try out the accessors:

>> book.title
=> "MacRuby in Action"
>> book.price
=> 10.0
>> book.title = "Foo"
=> "Foo"
>> book.title
=> "Foo"

You can now access and modify the values of the Book’s attributes using the accessor
methods. What about the increase_price method?

>> book.increase_price(5.00)
=> 15.0
>> book.increase_price(5)
=> 20.0
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To add amounts to the price, you can use float or integer values. 

RUBY WRAP-UP

We’ve introduced you to a good bit of Ruby basics. You’ll learn more Ruby code and
concepts as we work our way through the key concepts of MacRuby and Cocoa pro-
gramming. Take advantage of the plethora of Ruby resources out there because a
solid understanding of Ruby will help you write MacRuby applications.

 We’ve covered the basics of Objective-C and Ruby—the two languages that,
together, make up MacRuby. At this point, you can read Objective-C method signa-
tures, and you understand Ruby syntax. Next, we’ll move on to MacRuby itself. 

1.4 Diving into MacRuby
You’re already familiar with MacRuby’s foundation, so we can jump into the language
itself. In this section, we’ll first show you how classes are represented, and then move
onto method signatures. You’ll also learn how to create user interfaces and experi-
ment with calling Ruby and Objective-C methods from MacRuby.

1.4.1 Class structure

Each MacRuby object is implemented directly on top of its Objective-C equivalent. For
instance, suppose you want to create a string. Ruby has the class String and Objective-
C has the class NSString. In MacRuby, when you create a Ruby String, you’re also
creating an Objective-C NSString. What’s great is that the String/NSString has
access to the methods from both classes. Suppose the content of your Ruby String is
the all-lowercase phrase i am short. To modify the phrase to all uppercase, you can
use either a Ruby or Objective-C method. Both approaches shown in table 1.1 pro-
duce the same result: I AM SHORT.

This behavior is true for all MacRuby classes. In fact, if you do a little digging into the
classes, you’ll see that each MacRuby class inherits from an Objective-C class as well as
the Cocoa base class NSObject. An example using Macirb illustrates how you can dis-
play the ancestors of the MacRuby String class:

>> "i am short".class
String
>> "i am short".class.ancestors
[String, NSMutableString, NSString, Comparable, NSObject, Kernel]

Because of this inheritance, you can use the existing Cocoa and Objective-C APIs with
MacRuby. If you have a Ruby background, you can take advantage of your favorite fea-
tures of Ruby and vice versa for Objective-C. The approach that Apple has taken in

Table 1.1 Both Ruby and Objective-C have a method for capitalizing the letters in a string.

Ruby Objective-C

"i am short".upcase "i am short".uppercaseString
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this implementation gives you a great deal of flexibility when working with MacRuby.
For instance, you can use both Ruby and Objective-C libraries in your MacRuby proj-
ect, which gives you double the amount of resources.

 Let’s look again at the Objective-C Class structure. Remember the class hierarchy
you saw previously (see figure 1.1)? Table 1.2 shows a slightly modified version that
includes the MacRuby classes.

To illustrate the underlying implementation of the MacRuby classes, let’s look at an
example:

>> o = Object.new
=> #<NSObject:0x800818420>
>> o.class
=> NSObject

In the first line, you create a new Object. To find out what class it is, you call the class
method on the Object instance, and you can see that it returns back NSObject.
(Remember, every object in MacRuby inherits from NSObject.) You could do the same
thing with any of the other MacRuby classes shown in table 1.2 to see their respective
Objective-C class. Figure 1.4 shows how everything in MacRuby is inherited from
NSObject.

Table 1.2 MacRuby classes and the equivalent Objective-C classes

MacRuby class Objective-C class

String NSMutableString

Number NSNumber

Array NSMutableArray

Hash NSMutableDictionary

Object NSObject

NSObject

NSArray

NSMutableArray

NSString NSDictionary

NSMutableDictionary

HashArrayString

NSMutableString

Figure 1.4 In the MacRuby class hierarchy, everything is inherited from NSObject.
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Now that you have an overview of the MacRuby class structure, we can show you some
real MacRuby code. We’ll start by going over the syntax and method signatures. 

1.4.2 Creating MacRuby classes

In MacRuby, everything is an object, and classes define all objects. Creating your own
classes in MacRuby is as simple as creating classes in Ruby. Unlike Objective-C, you
don’t need a separate interface. Let’s create a MacRuby class. Open a text editor and
enter the following class definition:

class Book
end

You define a class with the class keyword and end it with the end keyword. By conven-
tion, you’ll name this file book.rb. The class has no instance methods and is as basic as
can be. By default, the Book class is a subclass of NSObject. If you want it to be a sub-
class of a different class, you define it as shown:

class Book < OtherObject
end

You declare Book a subclass of a fictional class named OtherObject, which gives the
Book class access to all its functionality.

 Let’s remove this subclass declaration and instantiate the Book class in the book.rb
file. To customize instantiation of the class, you’ll define an initialize method. In
the following code, you initialize the Book class outside the class declaration:

class Book
  def initialize
    puts "Hello, I'm a book"
  end
end
  
   Book.new

From the terminal, run book.rb to see if the Book class gets properly initialized when
you call Book.new:

$ macruby book.rb
Hello, I'm a book
$

As you can see, the Book class was properly instantiated, and the custom initialize
method ran, printing out Hello, I'm a book.

 You probably noticed that you initialized the class the same way you did in Ruby, by
using the .new function. MacRuby classes should be instantiated this way, whereas
Objective-C/Cocoa classes should be instantiated using alloc.init. Instead of using
NSString.new, always use NSString.alloc.init. Both functions will work, but using
alloc.init is how Objective-C classes are expected to be initialized.

 Now that you have an understanding of how to create MacRuby classes, let’s look
further into its syntax and method signatures. 
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1.4.3 Syntax and method signatures

MacRuby syntax is Ruby 1.9 syntax. If you know Ruby, you’ll find MacRuby familiar. If
you’re not that familiar, don’t worry—MacRuby looks just like the code you saw in the
Ruby introduction (see section 1.3.3) because it’s Ruby that you’re writing.

 You can use both the Ruby and Objective-C methods on a given MacRuby object.
Although this ability gives you a good deal of flexibility, you must be aware of the cod-
ing styles in Ruby and Objective-C.

 Method names in Ruby use snake-case letters (to_s), whereas Objective-C method
names use camel-case letters (stringWithFormat:). When writing MacRuby code,
you’ll see a mix of camel case and snake case in the code. Throughout this book,
you’ll use snake case in your custom method names because you’re writing Ruby 1.9.
When writing Objective-C methods in MacRuby, though, you must use camel case to
match the original method signature.

 Calling Objective-C methods in Ruby can sometime feel unnatural and verbose
because Objective-C uses a parameter/method name approach. The best way to get a
grasp of this naming convention is to practice with a few examples. Consider an
Objective-C method, such as the following:

[NSTimer scheduledTimerWithTimeInterval:0.40f target:self

➥ selector:@selector(doSomethingOnTimer) userInfo:nil repeats:NO];

Now let’s call this same method in MacRuby. After all, you have access to all the Cocoa
methods in MacRuby, right?

NSTimer.scheduledTimerWithTimeInterval(0.40, target:self,

➥ selector:"doSomethingOnTimer".to_sym, userInfo:nil,repeats:true)

You may have noticed the absence of brackets in MacRuby and the use of dot notation.
Pay attention to how you pass in the arguments to this method. You can see that the
named parameters in the original Objective-C method are treated like hash keys in
MacRuby. This syntax, in which you use colon syntax to create a hash, is new in Ruby 1.9

Ordered and unordered hashes/sets

In previous versions of Ruby, a hash is unordered. This means that you can’t count
on your hash returning its objects in the order in which they were added.

In Ruby 1.9, a hash has an order attached to its behavior. For example, if you add
items A, C and B to a hash in that order, they’ll remain in that order when you retrieve
the keys from that hash.

MacRuby is built on top of Ruby 1.9, but in MacRuby, hashes are unordered. MacRuby
hashes are implemented on top of the Objective-C class NSMutableDictionary,
which doesn’t support ordered sets. This is something to pay attention to if you’re
porting code from a standard Ruby 1.9 script or class to MacRuby.
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as opposed to the old way of using hash rockets (=>). Note also that when you pass argu-
ments to an Objective-C method, you must preserve the order of the arguments.

 In Ruby 1.9, hash keys are symbols, so the old way of creating a hash is still valid.
The following example shows how to create a hash using the older hash rocket syntax
that many people are familiar with:

h = {:a => 1, :b => 2, :c => 3}

To get the same result in Ruby 1.9, use the new colon syntax as shown:

h = {a:1, b:2, c:3}

Let’s refactor the NSTimer example using the traditional hash syntax:

NSTimer.scheduledTimerWithTimeInterval(0.40, :target => self,

➥ :selector => "doSomethingOnTimer".to_sym, :userInfo => nil,
➥ :repeats => true)

Either syntax is valid. Deciding which of the two you prefer is a matter of personal
preference.

You’ve seen how to transform an Objective-C method to the appropriate syntax for
MacRuby, but what about method passing? In section 1.3.2, we showed you how to cre-
ate a new NSArray using the alloc and init methods. As a refresher, here’s that code:

NSArray *myArray = [[NSArray alloc] init];

In MacRuby, the equivalent code looks like the following:

my_array = NSArray.alloc.init

Method names and parameters in MacRuby

Parameter names can affect the method names in MacRuby. When you’re using hash-
based named parameters to call Objective-C methods, all the parameter names must
match the Objective-C method signature. This can be a tricky-to-catch issue because
a typo in one of the parameter names can make it appear as though the method you’re
calling doesn’t exist on the object you’re calling. The following Objective-C Class meth-
od invocation includes an incorrect parameter name:

NSTimer.scheduledTimerWithTimeInterval(0.40, :target => self, :selector =>

➥ "doSomethingOnTimer".to_sym, :userInfo => nil, :repeat => true)

Can you see the error? The :repeats parameter is missing the s. Calling this produces
the following error:

NoMethodError: undefined method
"scheduledTimerWithTimeInterval:target:selector:userInfo:repeat:"
for NSTimer:Class

That one missing character is considered a name error because of the way Objective-
C methods handle parameters.
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Instead of chaining with brackets, you use the Ruby dot-syntax. Also, as a matter of
personal preference, you changed myArray to my_array, but either syntax is correct in
MacRuby.

 Suppose you want to turn the following Objective-C example, which combines
message passing with named parameters, into MacRuby code:

[@"Paul" stringByReplacingOccurrencesOfString:@"Paul" 

➥ withString:@"Brendan"];

Here’s the equivalent MacRuby code:

"Paul".stringByReplacingOccurrencesOfString("Paul", withString:"Brendan")

In MacRuby, the first parameter isn’t named. Every following parameter is expected to
be named using the withString parameter, as shown in the example.

 Now that you have an understanding of MacRuby syntax and how to convert
Objective-C methods, let’s take a look at how MacRuby gives you a choice of which
methods you can use. 

1.4.4 Using Ruby and Objective-C methods

MacRuby is unique in that it’s so transparent in exposing its underlying implementa-
tion. When you create a new MacRuby string, you can easily see both the Ruby and
Objective-C methods available to that String object. Standard Ruby provides the
methods function, which lists the methods on an object.

 The version of methods that MacRuby provides has two optional parameters: the
first defaults to true, and the second defaults to false. If you call methods with both
parameters set to true, it returns not only the Ruby methods, but also the underlying
Objective-C methods available on an object.

 The following code lists the Ruby methods available to a MacRuby String object:

>> "Hello".methods
=> [:to_yaml, :is_binary_data?, :is_complex_yaml?, :taguri, :taguri=, :to_c, 

:to_:ascii_only?, :valid_encoding?, :force_encoding, :encoding, 
:rpartition, :partition, :delete!, :tr_s!, :tr!, :count, :squeeze, 
:delete, :tr_s, :tr, :rstrip!, :lstrip!, :chop, :gsub, :sub, :center, 
:rjust, :ljust, :scan, :end_with?, :start_with?, :include?, :reverse, 
:chars...

What happens if you set the second parameter of the methods function to true? Run a
count and examine the length of the array that’s returned. Changing the parameter
value returns more methods:

>> "Hello".methods(true, false).length
=> 160
>> "Hello".methods(true, true).length
=> 584

The first line returns the number of methods available to the String object. The sec-
ond returns the number of methods available to the String object and includes the
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Objective-C/Cocoa methods from NSString. You’ll see that there are quite a few
Cocoa NSString methods!

 One of the best things about MacRuby is that you get to choose if you want to use
Ruby or Objective-C/Cocoa methods. If you’d rather use one over the other, nothing
stops you from doing so. It’s a matter of personal preference and what will get the job
done. This example uses the Ruby method capitalize and the Cocoa NSString
method capitalizedString:

>> "small string".capitalize
=> "Small String"
>> "small string".capitalizedString
=> "Small String"

Both methods accomplish the same thing: capitalize the first letter in each word. You
can also use both Ruby and Objective-C methods on the same line:

>> "small string".gsub(/sma/, "ta").capitalizedString
=> "Tall String"

You call the Ruby string method gsub, and then chain it with the Objective-C
NSString method capitalizedString. You have the freedom to mix and match these
methods as you like.

 Most people are drawn to MacRuby because they want to develop Mac applications
with great user interfaces. Let’s learn about the options for UI development. 

1.4.5 Creating user interfaces

Writing command-line tools is fun, but one of the biggest benefits of MacRuby is the
ability to use the Cocoa framework to develop applications that have nice user inter-
faces.

PROGRAMMATICALLY WITH NO TOOLS

One way to create user interfaces is to code them without any external tools or librar-
ies. Not many people will find this option appealing, mainly because of the verbose
and complicated syntax required. Let’s quickly examine the MacRuby code required
to create a graphical window, known as an NSWindow:

win = NSWindow.alloc.initWithContentRect([300,500,400,200],

➥ styleMask:NSTitledWindowMask | NSClosableWindowMask
➥ | NSMiniaturizableWindowMask | NSResizableWindowMask,
➥ backing: NSBackingStoreBuffered, defer:false)

This code creates a window that’s 400x200 pixels in size and positions the window 300
pixels to the right and 500 pixels from the bottom of the origin. The origin is at the
top-left of your screen. To create the interface elements, you write similar code that
specifies exact positioning, size, and any other options.

 Another way to create user interfaces is to use HotCocoa.
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HOTCOCOA

With HotCocoa, you can still programmatically create user interfaces, but you can do
the same in much fewer lines of code. HotCocoa provides a set of mappings that wrap
the standard Objective-C Cocoa API in a more Ruby-friendly and easy-to-configure set
of methods. HotCocoa is available as a Macgem and can be installed by running the
following from your terminal:

sudo macgem install hotcocoa

You’ll learn HotCocoa in-depth in chapter 9. For now, let’s see what it would take to
create the same window in the previous MacRuby example:

win = window :frame => [300,500,400,200]

Much easier, isn’t it? Now, let’s take a look at one more option for user interface devel-
opment: Interface Builder.

XCODE INTERFACE BUILDER

Interface Builder has long been the interface tool of choice for Cocoa development.
Interface Builder, previously a separate application, is now built in to Xcode 4, which
allows you to work on your code and interfaces all in the same IDE.

 Interfaces are created in .xib files. To create a window, you find an NSWindow from
the library. NSWindow contains a set of interface elements that you can use. Then you
drag the window over to your Interface Builder workspace and resize it to the correct
proportions. We’ll explore how to create advanced interfaces in chapter 3. For now,
we’ll show you how to use Xcode to build an interface for the second iteration of your
Hello World application. 

1.5 Hello World, part 2
You’ve already seen the not-so-quick-and-dirty way to create a Hello World application
using a MacRuby script. If you build applications with more complex user interfaces,
you don’t want to have to do it with straight MacRuby code alone.

 In this section, you’ll create a more complex application using Apple’s Xcode IDE.
You could use HotCocoa, but we’ll be going more in-depth into that in chapter 9 to
build something much better than a simple Hello World application. Throughout this
book, you’ll use Xcode to construct your Cocoa applications, so it’s important for you
to get a good feel for it from the start.

 When you write Cocoa applications, you spend most of your time in Xcode (Inter-
face Builder has been integrated into Xcode), which is our development environment
of choice for writing MacRuby Cocoa applications. With Xcode, you can edit and view
source code, build and compile applications, and test using the built-in graphical
debugging interface. It’s a robust IDE that we’ll use throughout this book to create
MacRuby Cocoa applications.
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 You can also use Xcode to create user
interfaces for your Cocoa applications. The
files that are associated with Xcode Inter-
face Builder often have the extension of
.xib or .nib. You don’t always need to use
Xcode to create UI elements, but you’ll see
that it’s much easier than programmatically
creating your views.

 Let’s get started. When you’re finished, you’ll have a one-window application like
the one shown in figure 1.5.

 The first step is to create a project file.

1.5.1 Creating an Xcode project

After you fire up Xcode, choose File > New Project to create a new application. Depend-
ing on which version of Xcode you’re using and which SDKs you have installed, the win-
dow that appears may look different than what is shown in figure 1.6. What you’re
looking for is the Application option under the Mac OS X templates. After you’ve
located this, find and click the MacRuby Application template and then click Next.

 You’ll be prompted to name the project, select an App Store category, and specify
whether it’s a Core Data application. For now, name the project Hello World.

 After the application is created, one of the files that has been created for you is
MainMenu.xib. Double-click this file to launch Interface Builder within Xcode. You

Figure 1.5 The finished Hello World 
application that you’ll create using Xcode

Figure 1.6 Starting a new project in Xcode
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can see in figure 1.7 that the template created quite a few files for you. We’ll be diving
deeper into some of these files later in chapter 3.

 Next, let’s focus on building the interface.

1.5.2 Creating the interface

Click on MainMenu.xib to edit the interface in Xcode. You should see something that
looks similar to figure 1.8.

Figure 1.7 A new project in Xcode. Double-clicking MainMenu.xib launches Interface Builder.

Figure 1.8 Editing the application interface in Xcode
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 You’ll need to get acquainted with sev-
eral utilities and windows, but we won’t go
into much detail about them yet. You’ll
learn more about them in later chapters.

 You may have noticed in figure 1.8 that
the project navigator doesn’t appear at the
left of the window and a new pane appears
at the right of the window. We hid the navi-
gator and chose to display the utility area
using the View options at the top-right of
the window (see figure 1.9).

 Let’s go over the tools shown in figure 1.8.

■ Library pane
The Library pane, which is at the lower-right of the document window in the
utility area, lists the available UI elements that you can add to your view. To add
any of these elements to your view, drag them into place.

■ Inspector pane
The Inspector pane, which is at the top-right of the document window, lets you
modify objects. Use the Inspector selector bar to modify attributes, effects, size,
bindings, connections, and the identity of the currently selected object.

TIP If you happen to close either of these tools, choose View > Utilities to re-
open them.

■ Dock
The other tool to pay attention to is the dock at the left of the document win-
dow. This shows the Interface Builder objects in your interface and displays
them in either an icon or outline (hierarchical tree) view. Use the outline view
to add new objects to your interface.

Because you’re building a simple user interface, it isn’t much trouble to create it first.
Double-click the window object in the document window and resize it. Make it
smaller by dragging the bottom-right corner and let go when it’s small enough. The
window should be just big enough to fit a button and a label that will display a small
amount of text.

 From the Object library (in the utility area), search for a push button object. After
you’ve located it, drag it to the bottom of the window. Click the button then bring up
the Attributes tab in the Inspector pane. From the Attributes tab, change the title
from its default Button to Good-bye.

 From the Object library, find a label object and drag it to the window. Place it
slightly above the button. From the Attributes tab, change the title of the label to
Hello World. Set the text to be center-aligned.

Figure 1.9 To hide/show panes, click items 
in the View selector.
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This will do for the Hello World interface (see figure 1.10).
 Now that the interface is in place, you can start working on the controller.

1.5.3 Creating the controller

Right-click the Hello World group (it looks like a folder), and choose Add > New File.
Choose Ruby File and name the new file HelloWorldController.rb.

 To be able to connect pieces of your interface to your code you’ll need to create an
IB (Interface Builder) outlet. To create outlets in the controller for the label and but-
ton, you’ll use the attr_accessor method. Outlets can be interacted with in Interface
Builder, which also sets up instance variables for these objects so that you can access
them from the controller.

 While you’re at it, let’s also create a class instance variable named hello. This
instance variable serves as a Boolean that checks the current state of the application.
Your code should look similar to the following:

class HelloWorldController
  attr_accessor :hello_label, :hello_button, :hello
end

Next, you’ll add a protocol method named awakeFromNib, which sets the default value
of the hello instance variable to true. This function is called when the controller is
initialized from the user interface. You set the default to true because this value deter-
mines which text to display on the label and button.

Figure 1.10 The finished Hello World interface
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def awakeFromNib
  @hello = true
end

The last piece of code you need to add to the controller is a method that the push but-
ton calls. This type of method is commonly referred to as an action, or an IB (Inter-
face Builder) action. These actions always take one parameter named sender. The
sender parameter is an instance of the object that called the specific method. In this
case, the sender is the button. Without this sender parameter, Interface Builder won’t
recognize this method as an action, and you won’t be able to connect it to the button.
If your action isn’t listed in Interface Builder, it’s always wise to check if you’re missing
the sender parameter.

 The changeLabel method does the following:

■ If the hello instance variable is true, it updates the label text to Good-bye and
changes the title of the button to Hello.

■ If the hello instance variable is false, it does the opposite, and updates the
label text to Hello World and changes the title of the button to Good-bye.

■ In each case, you also make sure to change the value of the hello instance vari-
able to reflect the state of the application.

Here’s the code :

def changeLabel(sender)
  if @hello
    @hello_label.stringValue = "Good-bye"
    @hello_button.title = "Hello"
    @hello = false
  else
    @hello_label.stringValue = "Hello World"
    @hello_button.title = "Good-bye"
    @hello = true
  end
end

The completed controller code is shown in the following listing.

class HelloWorldController
  attr_accessor :hello_label, :hello_button, :hello

  def awakeFromNib
    @hello = true
  end

  def changeLabel(sender)
    if @hello
      @hello_label.stringValue = "Good-bye"
      @hello_button.title = "Hello"
      @hello = false

Listing 1.3 HelloWorldController.rb
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    else
      @hello_label.stringValue = "Hello World"
      @hello_button.title = "Good-bye"
      @hello = true
    end
  end
end

Next, you’ll connect the outlets and actions in Interface Builder.

1.5.4 Connecting the interface and controller

From the Object library, look for an NSObject, which is represented as an object in the
library. Drag it to the bottom of the document window. You’ll use this NSObject to rep-
resent the HelloWorldController. (In case you forgot, you’re using an NSObject
because everything in MacRuby is a subclass of an NSObject.)

 With the NSObject selected, open the Inspector pane to update the class identity
of the NSObject. Click the third tab at the top-right of the Inspector pane (see figure
1.11), type HelloWorldController in the Class field, and then press Enter.

 Next, from the Inspector pane, click the tab with the arrow icon (third tab from
the right). This tab lists the outlets and actions that you have access to from the con-
troller. If you don’t see anything listed, make sure you typed the correct name of the
class. Next to each outlet and action is a circle/dot icon that connects each item to an
interface element. Use the icon to connect outlets and actions to the interface.

Figure 1.11 Adding HelloWorldController as an NSObject to the interface



35Summary

To connect the hello_button outlet to the button, click the circle/dot and then drag
the line over to the button. Do the same for the hello_label outlet, but drag the con-
nection directly to the label that you created. Last, drag the change_label action to
the push button. This tells the button to execute this action when it’s clicked (see fig-
ure 1.12). Without this connection, the button won’t execute any code when it’s
clicked.

 Save the interface, and then open the project navigator pane (use the View selec-
tor as shown in figure 1.9). You can now run the application!

 From Xcode, click Run at the top-left of the window (the Play icon). If you set
everything up correctly, you should be presented with the Hello World label and a
button that displays Good-bye. Click Good-bye, and the label text changes to Good-
bye and the button displays Hello.

 Congratulations! You’ve just created Hello World using Xcode. That wasn’t too
bad, was it? This application may have seemed more tedious to create in Xcode com-
pared to your self-contained MacRuby Hello World script, but if you write more com-
plex MacRuby Cocoa applications, having tools like Xcode and Interface Builder will
make things exponentially easier in the long run. 

1.6 Summary
You now have a basic understanding of MacRuby and know more than enough to be
dangerous in the language. You’ve also learned Ruby and Objective-C concepts and
how to combine the best of both languages in MacRuby. This material will help you

Figure 1.12 Creating a connection between the hello_button outlet and the push button
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further understand MacRuby application development. You’ve even created your first
MacRuby script, and dived right into Xcode to create your first application.

 With MacRuby, you have the power to do practically anything you want on the Mac
platform. You can write Cocoa applications as if you were writing in Objective-C, but
with the ease and simplicity of Ruby’s syntax. As we get further into the book, we’ll
dive deeper into MacRuby and go beyond the core concepts of the language. You’ll
also create more applications, which will give you a better understanding of the lan-
guage and the tools involved.

 Next, we’ll drill down deeper into MacRuby basics and work with the other tools
that you have at your disposal.
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